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How to prepare the pre- and post-test forms

(For assistants)

These guidelines explain how to produce the test forms that participants will complete. Each
participant will receive one pre-test form at the beginning and one post-test form at the end. The
content, layout and final production of the forms is very important to get valid results. Please
follow these guidelines step-by-step to produce the forms without mistakes. They will lead you to:

Format the document with your test items in preparation for the random assignment.
Assign the items to the pre- and post-tests following a computerized random assignment.
Select the right template to prepare your test forms.

Customize the test form template for your course.

Produce and check your final test forms.

moow>

A. Format your list of items in preparation for the random assignment of items

1. Open the document(s) that include(s) the list of all items that should come on the test. Save it
as a hew document.

In this new document, for each item, type » at the end of each key (i.e., correct answer).

3. Remove all automatic numbering. Number the stem (beginning) of the first item in the first
pair as la and its corresponding (paired) item as 1b. Number the next pair as 2a and 2b, etc.

............................................................................................................................................................... -

Example

la. Text of the stem of the first item in the first pair of the test
Text of response option a

Text of response option b ~

Text of response option ¢

Text of response option d |
I don’t know. ;

oo oTp

1b. Text of the stem of the second item in the first pair of the test
Text of response option a

Text of response option b

Text of response option ¢

Text of response option d *

| don’t know.

coooTp

2a. Text of the stem of the first item in the second pair of the test
a. Text of response option a *

b. Text of response option b
C. Text of response option ¢
d. Text of response option d
e. | don’t know.

2b. Text of the stem of the second item in the second pair of the test

a. Text of response option a
b Text of response option b
c Text of response option ¢ »
d. Text of response option d
£ | don’t know.

The sequence need not follow the example, but the numbering of 1a and 1b, 2a and 2b, etc.
should tell which items form a pair.
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4. Once your list shows each key and numbers each item as described above, print it and
make a back-up electronic version of it. You will need it for record checking.

B. Randomly assign items to the pre- or post test

5. Click the web-based “random template.” On opening, it automatically and randomly
determines which item within each pair should go to the pre-test, and which should go to the
post-test, like in the example view below.

g http:/ /siteresources.worldbank.org /\WBIINT /Resources,/RandomTemplate.xls - Microsoft

File Edit “iew Insert Format Tools Data  Acrobatk GoTo Favorikes  Help

N at Q G

Back Farward Stop Refresh Home Search Favc

Address 5Ej http: ffsikeresources . worldbank, org'WEIINT [Resources/Random Template, xIs

AZ | =

A | B |
This sheet indicates which item {within each pair) is randomly assigned
1 to the pre-test and which go to the post-test.
2 |
The following items fram your initial list T The following iterns from your initial list
3 go to the pre-test go to the posttest
4 1h 1a
5 2a 2b
B 3b Ja
I 43 4h
g8 5a Sb

6. Print the Excel/web page. (From the File menu, select print.) Then close this file/web window.

7. Open a new Word document. Paste the items from your list of items (with keys showing) in
the order of the printout from the template that randomly assigned items to the pre- or
post-test.! Put all items assigned to the pre-test first together. Then put all items that go to
the post-test together. In our example, you would get the following:

Example of list of items that will go on the pre-test

1b. Text of the stem of the second item in the first pair of the test
a Text of response option a

b Text of response option b

C. Text of response option ¢

d Text of response option d »

e | don’t know.

2a. Text of the stem of the first item in the second pair of the test
Text of response option a *
Text of response option b
Text of response option ¢
Text of response option d
__.1don’tknow.

paoop

1 If your test has fewer than 50 item pairs, please ignore the bottom rows of this printout
corresponding to items beyond what your test includes.



http://siteresources.worldbank.org/WBIINT/Resources/RandomTemplate.xls
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©caoow

Example of list of items that will go on the post-test

la. Text of the stem of the first item in the first pair of the test

Text of response option a
Text of response option b ~
Text of response option ¢
Text of response option d

| don’t know.

2b. Text of the stem of the second item in the second pair of the test

a. Text of response option a

b. Text of response option b

C. Text of response option ¢ »

d. Text of response option d
8. ldontknow.

8. Print your pre-test items and your post-test items, and check the following:

YV VYV VYVYVYV

There is the same number of items on the pre- and post-tests.

The items are in the correct sequence.

Each item is complete (i.e., one stem and all five response options, none truncated).
All options “e” are “I don’t know.”

The ~ is showing the key of each item.

The item assignment corresponds to what the web random template issued.

The formatting of the item (e.g., underlined negative terms in the stem) remains.

9. Once it is correct, delete “a” and “b” from the stem numbering. The item numbers in the pre-
test should be 1, 2, 3, etc. The same numbering applies to the post-test. See example:

e.

1
a
b
c
d
e
2
a.
b
c
d
e

1
a
b
c
d
e.
2
a
b
c
d

Example of list of items that will go on the pre-test
. Text of the stem of the second item in the first pair of the test
Text of response option a
Text of response option b
Text of response option ¢
Text of response option d ~
| don’t know.

. Text of the stem of the first item in the second pair of the test
Text of response option a *

Text of response option b

Text of response option ¢

Text of response option d

| don’t know.

Example of list of items that will go on the post-test

. Text of the stem of the first item in the first pair of the test
Text of response option a

Text of response option b »

Text of response option ¢

Text of response option d

| don’t know.

. Text of the stem of the second item in the second pair of the test
Text of response option a
Text of response option b
Text of response option ¢ »
Text of response option d
I dontknow.

10. Save your file. Later, you will paste its contents into the test forms templates.
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C. Select the right test form templates

11. Your test forms should be in the language(s) in which participants follow the course. A
test form should be in gne language only. There should be as many versions of the test as
there are languages in which participants follow the course.

For example, for a course delivered in English with all participants following through
translation in Russian, select the Russian template. For a course delivered in English with
some participants following in English and others in Spanish through translation, customize
both the English and Spanish templates.

Following this rule, click the list of test form templates and select the forms relevant to your
course. You will need at least one pre-test form template and one post-test form template.

12. In the list of test form templates, clicking a link in the table opens a Word document on the
web. Save each relevant template to your computer. (Pull down the File menu and save file
as a Word document.)

Note about electronic forms: The steps below assume that participants will answer the tests on
paper forms. If you plan to have participants answer electronically, please read the steps below
and adjust them to the electronic technology that you are using. The reviewing steps at the end of
the current document give tips on reviewing electronic forms.

Electronic forms could be used only if all conditions below are met.
a. All participants are computer literate.

b. Each participant has one computer in front of him/her at pre-test time for his/her own use.
Computers are not shared among participants. (In most cases, the computers will also need to be
connected to the web. Sometimes computers in training rooms are not web-enabled.)

c. Each participant has one computer in front of him/her at post-test time for his/her own use.
Computers are not shared among participants.

D. Customize the test form templates

13. In Word, open the pre-test template file you just saved.

14. In this file, pink indicates the areas that you should customize.” First, overwrite the pink text
with the relevant course information in the language of the test form.

......................................................................................................................................................................

[Course Title
Course Location
C'ourse Dates

Pre-Test

- The World Bank Institute will evaluate the course that you are attending in depth. For :

B S e

2 You may customize other areas of the test forms. If you do, please check the guidelines on what
should appear on test forms and adjust both pre and post-test forms, as needed. Notably, the
code to match pre- and post-tests by participant should be identical in both pre and post-tests.



http://web.worldbank.org/WBSITE/EXTERNAL/WBI/0,,contentMDK:20270037~menuPK:591801~pagePK:209023~piPK:335094~theSitePK:213799,00.html
http://siteresources.worldbank.org/WBI/Resources/What-should-appear-on-test-forms.pdf
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15. Further down in the file, you will find the place where to paste the pre-test items as shown in

the example below.

The purpose of these questions is not to test vou or other participants, but to evaluate our .
effectiveness in providing vou with a quality course. )

1. Type or paste the text of the pre-test item 1 stem

a. Type or paste the text of the pre-test item 1 response option a
b. Type or paste the text of the pre-test item 1 response option b
c. Type or paste the text of the pre-test item 1 response option ¢
d. Type or paste the text of the pre-test item 1 response option d
e. I don’t know.

Page Break

2. Type or paste the text of the pre-test item 2 stem

a. Type or paste the text of the pre-test item 2 response option a
b. Type or paste the text of the pre- test 1tem 2 response optzlon b

PR |

16.

Copy all items assigned to the pre-test and paste them over the pink text. If some of your text
remains pink, turn it black, as in the example below.

The purpose of these questions 12 hot to test you or other participants, but to evaluate our
effectiveness in providing you with a quality course,

1. Text of the stem of the second item in the first pair of the test
a. Text of response option a

b Text of response option b

C. Text of response option o

d Textofresponse option d ™

£ Tdon’tknow.

m2

Text of the stem of the first item in the second pair of the test
Text of response optiona ™

e

=

Text of response optmn b

Mmoo

17.

18.

19.

Save an electronic copy of your customized pre-test forms that is still showing the correct
answers. You will use this copy after the course to prepare the tabulation template.

You will now create the pre-test form that participants will actually answer. For this, save the
file as a new document with a new name.

Delete all marks that indicate which are the correct answers (e.g., the » at the end of
each key). To delete all » at once, pull down the Edit menu, and select Replace. In the dialog
box, type # in “Find what:”, and leave “Replace with:” blank, as shown in the example below.
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Find and Replace

Find Replace | Go Ta |

2l

Find whak: Ii

=]

Replace with: I

More ¥ Replace Replace Al Il Find MNexk I Zancel

=

20. Word will display a dialog box with the number of replacements. The number of
replacements should be the same as the number of items in the pre-test. If it is different,
check the pre-test file that has the keys showing and fix the keys. This will prevent mistakes

in the computation of the results after the course.

Microsoft Word |

@ Wiard has completed its search af the dacument and has made 20 replacements,

21. Click OK and close the Find and Replace dialog box.

22. Your pre-test items should now look like in the example below.

The purpose of these questions 15 not to test you or other participants, but to evaluate o
effectiveness in providing you with a quality course.

1. Text of the stem of the second item in the first pair of the test
Text of response option a

Text of response option b

Text of response option c

Text of response option d

T don’t know.

T 0 ToE

. Text of the stem of the first item in the second pair of the test
Text of response option a
Text of response option b
Text of response optionc

LTI =

ur

23. Read the introduction of the test form and adjust it, as needed. For example, if your
not sponsored by WBI, replace “World Bank Institute” with the relevant organ

course is
ization. If

participants will not get a binder, replace “on the first page of the binder” with something that
participants will have throughout the course, e.g., “on the back of your badge” or “on the
cover of your folder.” (You will make the equivalent relevant adjustment to the post-test too.)

Note about scannable forms: The forms that you have produced are not scannable, i.e., you will
not be able to pass them through a scanner to retrieve the responses in a spreadsheet format.

Investing in the scanning equipment and training for few courses may not be cost-effect
have a high volume of evaluations, and invested in scanning technology, follow the instr

ive. If you
uctions of

your scanning providers and adjust the marking instructions on the test forms accordingly.
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E. Laying out, printing, copying and viewing quality test forms

24,

25.

26.

27.

28.
29.

For paper forms: Every printer and printer driver prints differently! Before designing the
layout of your form, decide which printer and printer driver you will use, and make sure to
remain set on them while working on the layout. This will help ensure that your printout looks
like what you designed on screen.

Scroll down though your document from top to bottom and make sure that no items are split
onto two pages. If the beginning of an item appears on one page and the end on another
page, put your cursor at the very beginning of the item, and hit the Ctrl and Enter keys
together. This should push the item entirely onto the latter page.

Print a form and review it. If you decide to use photocopies, review them too. It is essential to
catch any issue that will be on the forms that participants will use, before they use it.
Problems discovered after data collection can’t be fixed!

The response options should all have the same format. Nothing in the appearance of the
items should give a clue to the correct answers.

No test item should be split onto two pages.

All the information should be clearly legible. Specially check the edges and the
shaded/colored areas, if any.

Repeat steps 11 to 29 for the post-test.

30.

31.

32.

33.

34.

35.

36.

37.
38.

For WBI: staple the post-test (not the pre-test!) in the back of the Level-1 evaluation forms.
Make sure that your Level-1 evaluation form includes at least one open-ended question.
Having at least one question where participants write an answer is useful to match pre- and
post-test forms.

The post-test form produced with the template does not have any open-ended question. If
your test form does not have any other means to get a writing sample of the participants,
please add an open-ended question, e.g., “any comments on the course”, below the last item.
(WBI staff may simply choose to add this question from the Level-1 evaluation form produced
through the WBI Client Reqistration System following the Client Level-1 Evaluation Toolkit
guidelines.)

Prepare one form per participant.

For electronic forms: Be aware that the tests are very likely to be displayed differently on
different screens. Computer speed may also vary greatly among users, so avoid fancy
designs.

Keep test takers from scrolling. Display one item per screen. Test your electronic forms on
different PCs.

The response options should all have the same format. Nothing in the appearance of the
items should give a clue to the correct answers.

Before launching the evaluation, systematically check that the data collected electronically
correspond to the selected responses.

Provide respondents with instructions on how to unclick a response, if clicked by accident.

Make the final submit button clearly visible.

Before the course, review the guidelines both on how to collect the pre-tests and how to collect
the post-tests to prepare an effective collection of quality data.



http://wbicrs/
http://intranet.worldbank.org/WBSITE/INTRANET/UNITS/WBIINT/0,,contentMDK:20168224~pagePK:135700~piPK:135698~theSitePK:136975,00.html
http://siteresources.worldbank.org/WBIINT/Resources/How-to-collect-pre-test.pdf
http://siteresources.worldbank.org/WBIINT/Resources/How-to-collect-post-test.pdf
http://siteresources.worldbank.org/WBIINT/Resources/How-to-collect-post-test.pdf

